Mac 101: Mac essentials
If you're brand new to the world of computers and are just starting to get up and running,
relax—using a Mac is simple. This lesson introduces you to the basic principles of
interacting with your computer's interface, and teaches you how to do basic tasks on your
Mac.

New to the Mac? Then start with this lesson to learn the basics.
Products Affected
Mac OS X 10.0, Mac OS X 10.3, Mac OS X 10.2, Mac OS X 10.1, Mac OS X 10.4, Mac OS X 10.6,
Mac OS X 10.5
Pointing, clicking, and getting around
If you haven't quite got the hang of getting around the Mac desktop and Finder windows,
start here; otherwise feel free to skip ahead to "Setting Up Accounts." Let's talk about the
basic principles of using your computer.
When you move your mouse or finger on a trackpad, it controls a pointer (also known as a
cursor) that moves across your screen. The pointer allows you to select and interact with
the various items on your screen, including selecting files, clicking buttons, dragging
sliders, and so on. Sometimes the pointer may look like a hand, a crosshair, an I-beam, or
some other icon, depending on what you're doing and the application you're using.
For example, if you're using Safari to view this webpage and move the pointer across it,
notice that it turns into an I-beam when you move it over text or a text field. When you see

this, you can usually interact with the text or field below it. When you move the pointer
over a button or link, the pointer turns into a hand, letting you know that you can click on
the item. Sometimes when your Mac is hard at work, your pointer may temporarily turn
into a colorful spinning disc, which generally indicates that a task is in progress.

Depending on what you're doing and what application you're using,
your pointer (far left) may take on a new appearance
Clicking your mouse button or trackpad button once allows you to select the item that your
pointer is on. In other words, if your pointer is on a file's icon, clicking once will select it. If
the pointer is on a button or link, clicking once will activate it. If your pointer is on a text
field, clicking once highlights the field and allows you to start typing text in it. If you see a
blue button in a dialog, such as in a Print or Save dialog, you can press the Return key to
select it instead of using your mouse.
If you want to open a file, folder, or application, click your mouse button twice. This is
known as double-clicking. In general, you'll need to double-click items if you want to open
them from a Finder window or the desktop. The exception to this is opening stuff from the
Dock—just click once on an icon in the Dock to open it.

Move your mouse to move the pointer over a file, folder, or application icon
and click once to select it, or double-click to open it.

Working with applications
You don't have to quit an application before opening a new one. In fact, you can open and
use several applications at the same time, depending on how much memory you have
installed in your computer. For example, when you open Mail, you can have it run in the
background (meaning, it's not the current active application) to check email as you work in,
say, iPhoto. And while you're editing your pictures, you might also want to open iTunes to
listen to some music.
Most applications share common menu commands and keyboard shortcuts, key
combinations (such as Command-C) that are pressed together to perform a certain menu
command. For example, in any application's File menu, you'll find commands to Open
(Command-O) and Save (Command-S) files. Likewise, you'll find Copy (Command-C), Paste
(Command-V), and Undo (Command-Z) commands in the Edit menu in most applications.
Whenever you use an application, be sure to scope out its preferences from the application
menu, choose Preferences) to set it up to your liking.
When you open an application, closing the window doesn't necessarily quit the application,
if you see a blue light below the application icon in the Dock, the application is still running.
To quit an application, either choose Quit Application Name from the application menu, or
press Command-Q.
About user accounts
When you get a brand new Mac, the first thing you do when you start it up for the first time
is create a user account. Maybe you did this on your Mac or someone did the deed for you.
Regardless, your Mac currently has a user account set up on it. If your Mac only has one
user account, that account is an administrator account.
An administrator account allows you to have access to all areas of the computer, install and
update software, create and maintain other user accounts, and more. If a Mac-savvy friend
set up your computer, he or she may have created a non-administrative account for you. If
you set up your computer, you are the administrator. If you're unsure of what type of
account you have, do this:

Open Accounts preferences to determine the types of accounts for each user on your
computer.
1. From the Apple menu, choose System Preferences to open the window.
2. Click Accounts to display the Accounts preferences.
3. Your account is listed under the My Account header in the left pane.
Below your account name, if you see the word "Admin," you have an administrator account
and all the privileges that go with it. If you see the word "Standard" or "Managed," someone
else who either shares or set up your computer has administrative access. You will not be
able to install software or create user accounts. If you want this power, you will need to
convince the person who has administrator access to your computer, but before you do,
you might want to read through all the Mac 101 lessons first.
If you have a "standard" account, you have limitless access to all the applications on your
Mac, and can configure them for your user account. If you have a "managed" account, the
person who has administrative access has put limitations on what you can and can't access.
If this is the case, talk with your administrator to find out the scope of your access.
No matter how many accounts your computer has, each user's files, media libraries,
preferences, and other information is kept separate from other users, so you don't have to
worry about your housemates ransacking your private files—unless they figure out your
password.
Changing account passwords
Speaking of passwords, make sure that you use a good one. Don't choose your name (or
someone else's), your birthday, a pet's name, or any other easy-to-guess word. Choose
something that uses a combination of letters, numbers, and punctuation characters for
better security.
Here's how to change your user account password.

If you need help creating a good password, click the key button to open the
Password Assistant window and let your Mac generate password candidates for you.
1.
2.
3.
4.
5.

From the Apple menu, choose System Preferences.
Click Accounts to display its preferences.
Click the Password tab to display its pane, then click Change Password.
In the resulting dialog, type your current password in the Old Password field.
Type a new, hard-to-guess password in the New Password and Verify fields, then click
Change Password.

So what happens when you forget your user account password? You can workaround this
issue quite easily. Just insert the Mac OS X Software Install disc that came with your Mac,
then restart the computer while holding down the C key to start up from the disc. When the
Installer appears, choose Reset Password from the Installer menu, and follow the
onscreen instructions to change your password.
For added security, don't have your Mac automatically log you in when you start up your
computer; this function is enabled by default. To disable it, click Login Options in Accounts
preferences, and deselect the "Automatically log in as..." checkbox. Please note that each
time you start up your computer, you'll need to log in with your user account password.
Creating and managing user accounts
If you have administrative access, here's how to create a new user account.
1. In Accounts preferences, if the lock icon in the bottom-left corner is locked, click it and
type your administrator password in the resulting dialog to unlock it.
2. Click the plus sign (+) button at the bottom to create a new account.

3. In the resulting dialog, type the person's name in the Name field, type a one-word
name in the Short Name field this is the name that gets attached to a user's files—
don't use spaces or punctuation marks, and type a password in the Password and
Verify fields.
4. Click Create Account or press Return.
5. If you want this person to have administrator access (think hard about this), click the
Security tab and select the "Allow user to administer this computer" checkbox.
If you don't make this user an administrator, he or she can access all applications on the
computer as a Standard account. If you want to enforce stricter access control, select the
user account, select the Enable Parental Controls checkbox and then click the Open
Parental Controls button. You've now created a Managed account with various options,
such as what applications can open, content filters, mail and chat limitations, logs of sites
visited or applications opened and even time limits.

If you have administrative access, you can create user accounts to allow friends and family
to use your computer with parental control.
Many kids would sit at the computer for days if you let them. Fortunately, Leopard makes it
easier to set the rules. Just enter bedtime and time limits for using the Mac, specifying

different times for weekdays and weekends if you wish. Parents happy, kids happy
(relatively).
Storing passwords in Keychain
Getting email, visiting certain websites, accessing servers, and opening password-protected
files and applications on your Mac require passwords. But you don't have to keep track of
every password you have; instead, keep your passwords in Keychain, a utility that lets you
create one or more keychains to store your sensitive passwords.
Your Mac starts you out with a single keychain that gets created when you first log in to
your user account. By default, it has the same password as your user account, and
automatically unlocks whenever you log in to your account.
When you access a site, application, or other item that asks for your password, a dialog may
open after you type it, asking if you want to add the password to your keychain. Click Add
to add it. The next time you access that item, Keychain fills in the password for you. You can
also add passwords manually: Open Keychain Access in the Utilities folder inside the
Applications folder, choose New Password Item from the File menu, and enter the
information and password for the item.

Keychain Access allows you to see all the password items that are currently stored on the
selected keychain.
If you ever forget a password that's stored in Keychain, do this:
1. Open Keychain Access.
2. From the list, double-click the item whose password you can't remember.
3. In the resulting window, click the Attributes tab, then select the "Show password"
checkbox.
4. In the resulting dialog, type your keychain password. If you're using the default
keychain, the password is the same as your user account. Click Allow Once to display
your password once, or click Always Allow to always display your password in
Keychain.

For added protection, you may want to create another "more personal" keychain that
doesn't automatically unlock each time you log in to your user account. To create a
keychain:
1. Open Keychain Access
2. From the File menu, choose New Keychain.
3. In the resulting dialog, type a name for your keychain in the Save As field, choose
where you want to store it from the Where pop-up menu, and click Create.
4. In the resulting dialog, type a good password for this keychain in the Password and
Verify fields, then click OK. Click the key button if you need help choosing a good
password.
Tip: For more information on using Keychain, choose Mac Help from the Help menu and
type "keychain" in the Search field.
Working with discs and volumes
Many Apple computers come with an optical drive that allows it to read and play CDs and
DVDs. If your Mac has a combo drive, you can burn CDs too. If you have a SuperDrive, you
can burn CDs and DVDs. If you have a slot-loading optical drive, just insert a CD or DVD into
the slot and your Mac will suck the rest in. If you have a drive that has a door, press the
Eject key on your keyboard (the triangle with the line underneath) to open the disc tray,
insert your disc, and press the Eject key again to close the tray.

To eject a disc or volume, drag its icon to the Eject icon in the Dock, or click its Eject button
in a Finder window.
Your disc will appear on your desktop in icon form. Depending on what type of disc it is
(audio CD, picture CD, blank recordable CD, DVD-Video, etc.), your Mac may automatically

open an application that can be used with the disc. When you are done with a disc, you can
either drag the disc icon to the Trash to eject it or click the Eject icon next to the disc in any
Finder window.
These same principles apply to volumes, including external FireWire or USB hard drives,
iPods, digital cameras, USB flash drives, and servers on a network. When you connect these
types of devices to your Mac or connect to a server from your Mac, an icon for the volume
appears on your desktop. When you're done with it, drag the icon to the Trash or eject it in
a Finder window.
Update and install software
Your Mac has a built-in feature called Software Update that allows it to automatically check
for available updates from Apple daily, weekly, or monthly when your computer is
connected to the Internet. It takes into account the software you have installed on your
computer, and new updates released by Apple so that it only shows you the relevant
updates.
You can also download software from Apple Downloads and install the software yourself.
To install software, just double-click the installer file and follow the onscreen instructions.
Here's how to have Software Update update software for you.

Software Update can automatically check the Apple website for updates that are relevant to
your installed software.
1. From the Apple menu, choose System Preferences, then click Software Update to
display its preferences.
2. To enable automatic checking, select the "Check for updates" checkbox, then choose
Daily, Weekly, or Monthly from the pop-up menu to set the frequency.

3. To have Software Update automatically download important updates in the
background, meaning, it does this while you work on other things on your Mac, select
the "Download important updates in the background" checkbox.
4. Click Check Now to have Software Update check for updates. If it finds any, it'll display
the available software in the Software Update window.
5. To install the software it finds, select only the items you want by selecting the
checkboxes, then click Install Items to download and install all selected items.
6. Next time, Software Update will automatically launch at your set frequency to show
you the latest updates.
This lesson is from the following website:
http://support.apple.com/kb/HT2477
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